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INTRODUCTION 

Basically, the Xpeaker product consists of three clearly discernable 
parts: 

 An IDE (Integrated Development Environment) oriented 
equally towards developers of Xpeak based applications and 

Services. 

 A combination of Xpeak Services covering a wide range of 

hardware, vendors and models. 

 A Xpeak Server which provides with a way to test the 

available Xpeak Services. 

Xpeaker's IDE is a Plugin which is fully integrated into Eclipse 
(www.eclipse.org ). Eclipse is a platform for tools integration created 

by an open source community. Eclipse has formed an independent 
open system around royalty-free technology and a universal platform 

for tools integration.  

In this way, developers benefit from a unique programming 

environment which can be used to develop their applications, test 
Xpeak services, create new commands to add to Xpeaker or develop 

their own Xpeak Services. All this can be done without having to 
change tools. 

For all users, this manual will explain everything from tool installation 
to specific details on the use of it. What it does not set out to do is to 

serve as a programming guide for programs based on Xpeak or the 
Xpeak Services themselves.  

http://www.eclipse.org/
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INSTALLATION GUIDE FOR ECLIPSE 3.1 TO 3.2 
 

Start Eclipse (Version 3.1 or 3.2). 

 

Select the menu Help -> Software Updates -> Find and Install: 

 

 

Select option Search for new features to install: 
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Create a New Remote Site 
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Type a Name and the URL (http://www.cashware.biz/xpeakerupdates) as 
shown below: 
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A new element will be created in the sites list. Select it and press Finish to 
continue 
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Once connected to our server, the following screen will appear: 

 

 

Select the option “Show the latest version of a feature only” and press Next 



                                                                                                              

Página: 10 

 

Read the license carefully and if you agree, accept it and press Next 
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Xpeaker Plug-in version and the Installation Directory will be shown 

 

Press Finish y to start downloading the plug-in. A progress dialog will appear. 
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To continue, press Install All 

 

 

Note: If the Verification window shows a warning about installing an unsigned feature, 
you can ignore it.  

Once the plug-in installation is finished, Eclipse must be restarted. Press Yes to 
continue. 
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After starting Eclipse again, select the menu option  Window → Show View → 
Other: 

 

Open Xpeaker level and select Xpeaker element. Press OK: 
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Xpeaker installation wizard will appear. Type the directory in which Xpeaker 
files will be stored (you can access the file system pressing the icon ). Once 

the path is typed or selected, press Next. 
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If you have User and Password, type both. Otherwise use the guest user with 
any password (6 characters required). Configure, if needed, your Proxy 

settings. Press Next to continue. 
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Select the files you want to install and press Finish: 

 

 

The downloading process will start. It can take some minutes. 

 

 

Finally, you must restart Eclipse pressing OK in the following dialog: 
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You will notice that two new projects have been added to your workspace: 
Xpeaker and XpeakerServices-Xpeaker, with the source code of the Xpeaker 
plug-in and Xpeaker Services, respectively. In order to update and download 
the latest version of the source code, press the right button of the mouse at any 

level of the project and select the option Xpeaker Resource Safe → Get 

Last Version. If you execute this option over the name of the project, all the 

changes will be downloaded.  

Following dialog will be shown. Press OK to continue 
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A table containing the downloaded and updated files will be displayed.  

 

 

 

Automatically, each time Xpeaker is started, it will check if there is a new Plug-
in version in the server. If so, you will be advised whether to proceed 
downloading or not. You can also check manually if there is a new version, just 

clicking the option Software Update.  
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You can also run the installation Wizard executing the option     Installation 

Wizard from the main menu 

 



                                                                                                              

Página: 23 

INSTALLATION GUIDE FOR ECLIPSE 3.3 TO 4.3 

 

Start Eclipse (Version 3.3 to 4.3). 

Select the menu Help → Install New Software: 
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Add  a New Software Site:  

 

 

 

Type a Name and the URL (http://www.cashware.biz/xpeakerupdates) as 
shown below: 

 

 

 

Once connected to our server, the following screen will appear: 
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Make sure that the ‘Show only the latest versions of available software’ is checked and 
press Next. 

 

 

 

 

 

Xpeaker Plug-in version and the Installation Directory will be shown 
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Press Next. 
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Read the license carefully and if you agree, accept it and press Finish: 

 

 

A progress dialog will appear. 
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Note: If the Verification window shows a warning about installing an unsigned feature, you can 
ignore by pressing ‘OK’: 

 

 

 

Once the plug-in installation is finished, Eclipse must be restarted. Press 
‘Restart Now’  to continue. 

 

 

After starting Eclipse again, select the menu option:  Window → Show View 

→ Other: 
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Open Xpeaker level and select Xpeaker element. Press OK: 
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Xpeaker installation wizard will appear. Type the directory in which Xpeaker 
files will be stored (you can access the file system pressing the icon ). Once 

the path is typed or selected, press Next. 
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If you have User and Password, type both. Otherwise use the guest user with 
any password (6 characters required). Configure, if needed, your Proxy 

settings. Press Next to continue. 
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Select the files you want to install and press Finish: 

 

 

 

The downloading process will start. It can take some minutes. 

 

 

 

Finally, you must restart Eclipse pressing OK in the following dialog: 
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You will notice that two new projects have been added to your workspace: 
Xpeaker and XpeakerServices-Xpeaker, with the source code of the Xpeaker 
plug-in and Xpeaker Services, respectively. In order to update and download 
the latest version of the source code, press the right button of the mouse at any 

level of the project and select the option Xpeaker Resource Safe → Get 

Last Version. If you execute this option over the name of the project, all the 

changes will be downloaded.  
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Following dialog will be shown. Press OK to continue 

 

 

 

A table containing the downloaded and updated files will be displayed.  

 

 

 

Automatically, each time Xpeaker is started, it will check if there is a new Plug-
in version in the server. If so, you will be advised whether to proceed 
downloading or not. You can also check manually if there is a new version, just 

clicking the option Software Update.  
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You can also run the installation Wizard executing the option  Installation 

Wizard from the main menu 
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INSTALLATION GUIDE FOR ECLIPSE 4.4 TO 4.7 
 

Start Eclipse (Version 4.4 to 4.7). 

 

Select the menu Help → Install New Software: 

 



                                                                                                              

Página: 38 

Add  a New Software Site:  

 

 

 

Type a Name and the URL (http://download.eclipse.org/eclipse/updates/4.4) as 
shown below: 
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Once connected to the server, the following screen will appear: 

 

 

Select Eclipse Test, Examples and Extras -> Eclipse 2.0 Style Plugin Support and 
press Next. 

Read the license carefully and if you agree, accept it and press Finish: 

A progress dialog will appear. 
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Once the plug-in installation is finished, Eclipse must be restarted. Press 
‘Restart Now’  to continue. 

 

 

After starting Eclipse again, follow the steps included in INSTALLATION 
GUIDE FOR ECLIPSE 3.3 TO 4.3 
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INSTALLATION GUIDE FOR ECLIPSE 4.8 OR HIGHER 
 

Sorry but, for now, Xpeaker plugin is not available for Eclipse version 
4.8 or higher. 
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ECLIPSE VIEWERS 

The Xpeaker Viewer is the usual start up of this application and 
permits testing of Xpeak services and creation of packs of services. 

It is presented under two panels (Devices and Forms), each with a 
tree that contains the elements of each type and a menu with 

different possible actions.  

DEVICES 

 

 

Shows a tree with available Xpeak services. These services are 
located inside the eclipse workspace in the XpeakServices-Xpeaker 

project directory or XpeakServices-XpeakerPro in the case of a Pro 
license. 

 

 

The tree will have the following levels: 
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 Xpeak Servers. As we will see later, different Xpeak Servers can 

be defined, with different ways of retrieving the Xpeak Services. 

 Manufacturer 

 Device type (Alarm, ATM, Passbook, Recycler, etc.) 

 Device Model or Name 

 Xpeak Services which are part of the device and configuration 

parameters for this services 

The ‘Configuration’ branch contains all the service configuration 

parameters including common parameters, connection parameters, 
and service specific parameters.  

A double click on any given service will open it using the Device 
editor.  

The options available on the menu are:  

 

 Reload: Close and open again the Xpeak Server making 

effective any change made on any Service. 

 Refresh: Ask the current running server to  give the list of 

available services, so if any new service was added, it will 
appear alfter presing the ‘Refresh’ button. 
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 Generate Pack: This option is used to export some Xpeak 

Service to a jar file so it can be used in a separte Java 

application. Once you click this option, the following dialog 
will show up: 

 

 In this dialog, you can choose a set of Xpeak Service which 
will be included in the jar file. The name of the jar file can be 

established with the editable combo box in the upper-left 
corner labeled as ‘Name:’. On the upper-right corner, there 

is another editable combo labeled as ‘Server:’. In this combo 
it is necessary to set a pack type Server which the generated 

pack will be attached to. 

 Once the name and server are filled, you can either Save the 

current pack, in which case the Name will be saved and will 
appear as an option in the Combo in further pack 

generations,  or Generate the pack, which will generate a jar 
file with the specified Name in [Xpeaker Directory]/Packs. 
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After clicking ‘Generate’, a screen showing the generation 

process will be shown: 

 

 

 Delete Pack: Deletes the currently selected pack. It is 

possible only to delete packs previously generated with the 
‘Generate Pack’ option, the ones that are attached to a 

Xpeak Server of type pack. 

 Software Update: Allows access to the Xpeaker software 

updates. The checking of available updates is performed 
automatically when Xpeaker is initiated, indicating, if 

applicable, their existence in order to proceed with their 
loading. If updates exist, a dialog box will be shown to 

confirm loading.  
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 Installation Wizard: Launches the installation wizard again so 

it is possible to reinstall or fix the required files and also 

change the configuration. 

 About Xpeaker: Shows a dialog box with the version of the 

update in process.  
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FORMS 

 

 

 

Shows a tree with the forms available in the directory indicated by 

the values that can be edited through the Eclipse Preferences options 
(See section Eclipse Preferences). 

The forms are stored in XML format, so they should have .xml 
extension. 

The tree will have one level for each sub-directory found in the user’s 
file structure. This will be indicated by the icon  and the final files 

will be indicated by the icon  . 

Double clicking on a final file will open the file using the Forms Editor.  

Right-clicking on the forms window will open a menu with the 

following options: 

 

 

 Create a new Folder: Creates a new folder at the level the 

right click was done. Inside folders you can create forms and 
other folders. 
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 Add new form: Creates a new form under the folder you 

double-clicked in the first place. 

 Delete Selected File: Deletes the selected file.  

 Copy Selected File: Copies the selected file so it can be 

duplicated or pasted in another folder. 

 Paste Last Copied File: Pastes the last copied file in the 

selected folder. 

 Rename Selected File: Open a dialog to enter a new name 

for the selected file. 
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ECLIPSE EDITORS 

DEVICES EDITOR 

Editor which allows the management of a device; running commands 
and showing information about this, the Xpeak specification and the 

traces generated by its use.  

It consists of the following panels: 

 COMMANDS 

 

 

This panel allows the user to work with the commands available for 
the device. It consists of the following sections: 

 Menu: Menu of buttons with the following actions: 

 Save Command Parameters: Saves the value of the 
command parameters.  

 Delete Combo Selection: Deletes the configuration of the 
command parameters selected in the combo.  
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 Clear Trace Data: Clears the data from the   Trace panel. 

 Define Trace Level: Shows a dialog box which allows the 

level collected by the command trace to be defined, and 
which will be shown in the  Trace panel. Its effects are 

immediate. 

 

There are four levels of definition: 

 Service: Shows information at Xpeak command level, 

i.e. every xpeak command with its input arguments 
and returned data will be traced.  

 Protocol: Shows information about the commands at 
low level, close to device specific commands.  

 Connection: Shows the information sent and recevied 
from the communication port, which can be serial, usb 

or TCP/IP.  

 Debug: Shows debug information. This information is 

service dependent meaning that it can change from 
one Xpeak service to another. 

Besides selecting the trace level, it is possible to control the 
size and location of the traces with these other parameters: 

 Reduced: When this option is enabled the service 

level traces are drastically reduced to show only 
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significant input and output data for each command. 

Debug and Connection traces are not reduced. 

 Server: When the option ‘Store in Server’ is enabled, 
the traces are generated in a file located in the path 

indicated by the field ‘Server Path’. The option 
‘Maximum Days Stored’ indicates the maximum 

number of trace files that will be kept in the ‘Server 
Path’. When this maximum is reached, the older file 

will be erased, so the traces are saved cyclically. 

 Clear Historical Data: Clears the data from the  Historical  

panel in the  Trace panel. 

 Show/Hide Historical Data: Allows the information from the 

 Historical panel to be shown or hidden. By default this 
will be hidden.  

 Refresh Command Tree: Updates the command tree.  

 Run Command: Runs the command selected in the tree.  

 Command Tree: This is shown on the left hand side and 

contains the device commands (both general commands and 
those specific to the device). Initially the command Initialize 

will be highlighted. 

A right click on the mouse will open a menu with the following 

actions:  

 Save Command Parameters: Saves the value of the 

command parameters.  

 Run Command: Runs the command.  

 Import Data: Allows to import an XML file with values for 
the command parameters. This file was previously generated 

with the ‘Save Command Parameters’ option. 

 Parameters Panel: Situated in the top right this shows, if 

applicable, a set of editable fields with the command 
parameters. Above it there are two combos, one indicating the 

version of the Xpeak Specifications which is being used and the 

other one with the name of the set of assigned values. To save 
a value assignment simple write a name in this combo, select 

the values and click on the button  Save Command 
Parameters. 
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The values are also saved when the command is run (  Run 

Command), assigning them the name Last Execution, option 

that will be selected by default.  

 Information Panel: An HTML page, shown on the bottom 

right, which details the command characteristics and, if 
necessary, a description of each parameter.  

When a command is run its progress will be shown in this 
panel; the events and results that have been produced, the 

details of these events, etc. In order to be clearer, this data will 
be shown in a reduced format: 

 

Additional information can be shown by clicking on the desired 

event:  

 

This data is recorded in the Historical, if this option is activated 

( ). 

Furthermore, five utilities are included in the upper section of 

the information page: 

 Prints the information. 
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 Searches for a string in the page. 

 Allows the page to be sent by e-mail. By default it will 

be sent to the Xpeaker support address. 

 Expands the detailed information of the command 

execution. 

 Hides the detailed information of the command 

execution. 

 HISTORICAL 

This panel shows the incidences that are being produced by the 
running of different commands. It consists of the following sections: 

 Menu: Menu of buttons with the following actions: 

 Save Historical Data: Saves the historical data to a file. 

 Browser Back: Shows the previous page. 

 Browser Forward: Shows the next page. 

 Clear Historical Data: Clears the data from the historical 
panel.  

 Show/Hide Historical Data: Allows the information to be 

shown or hidden. By default it will be hidden.  

Historical Panel: HTML page which records the incidences of 

the commands being run. In order to be clearer this data will be 
shown in a reduced format. If more information is required, this 

can be seen by clicking on the desired section. This data is 
recorded if the option is activated ( ). 

The following utilities are included on the same page:  

 Opens all levels of information on the page.  

 Closes all levels of information, showing only a summary.  

 Prints the information.  

 Searches for a string in the page.  

 Allows the page to be sent by e-mail. By default, it will 

be sent to the Xpeaker support address.  
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 TRACE 

Panel which maintains a log of all the traces generated by the 

application and whose sensitivity level can be indicated using the 
Define Trace Level  option. It consists of the following sections:  

 Menu: Menu of buttons with the following actions: 

 Save Trace Data: Saves the Trace data to a file. 

 Browser Back: Shows the previous page. 

 Browser Forward: Shows the next page. 

Clear Trace Data: Clears the data from this panel. 

 Define Trace Level: Shows a dialog box which allows the 

command trace level to be indicated, which will then be 
shown in the information panel.  

 Trace Panel: HTML page which shows all the incidences of the 
commands being run, such as date and time, named function, 

returned values, statuses, errors, etc. 
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The same page includes the following options: 

 Prints the information. 

 Searches for a string in the page.  

 Allows the page to be sent by e-mail. By default it will be 

sent to the Xpeaker support address. 
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 INFO 

Panel which records the different information and documentations 

related to the service. It has one menu option: 

 Save Modifications Info: Saves the modifications data to a 

file.  

and three panels containing various information: 

 Device: Includes the characteristics of the service, indicating 
the functions supported and how they operate. It comes in PDF 

format and is displayed using the Acrobat Reader utility. 
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  Server: Contains an explanation of the Xpeak architecture 

with examples of possible scenarios and how the different Xpeak 

servers fit in each scenario. It comes in PDF format and is 
displayed using the Acrobat Reader utility. 
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 Modifications: Includes the various modifications which have 

been made to the service, including a detailed description of 

them, their date and the module affected: 
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FORMS EDITOR 

Editor which allows a Xpeaking XML form to be managed.  

The editor analyses the XML file, and generates all the corresponding 

elements to graphically represent the form. 

The base of this editor is an editable tree containing all the properties 

for each item, which will differ depending on whether it is dealing 
with a form or a field. 

FORMS 

When a form is selected, e.g. after clicking in the background in the 

form editor, a tree is generated in the left side of the editor window 
with the configurable parameters of the form: 

 

The form parameters that can be configured are: 

- Size: width and height measured in inches. 

- Grid data: width and height of each grid square 
measured in inches. A checkbox ‘Show’ indicating 

whether the grid should be shown or not and a 
checkbox ‘Adjust’ indicating if the fields will 

automatically adjust to the nearest grid cells. 

 

 
Grid 

 
No grid 
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When a field is selected in the form editor, the tree is then refreshed 

with the parameters concerning the field in question: 

 

The menu options are the following: 
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 New Field: Adds a new field to the tree. The new item will 

have the default values, and will be named New- followed by 

the number it occupies in the Fields list. 

 Undo: Undoes the last action. 

 Copy: Makes a copy of the selected item, allowing it to be 
pasted at a later date using the function  Paste. 

 Paste: Pastes the last item copied by the function  Copy. 

 Zoom Minus: Zooms out the form editor view. 

 Zoom Plus: Zooms in the form editor view. 

 Select All: Selects all the items defined within the form. 

 Remove All: Deletes all the items defined within the form. 

 Remove Selected: Deletes all the selected items. 

 To Front: Brings the selected field on top of all the set of 
items. 

 To Back: Sends the selected field to the bottom of all the 
set of items. 

 

Finally, some extra options are available in the menu on the top of 
the editor: 

 Save Form: Saves the form with the values contained in the 
tree.  

 Print: Sends the form to a Printer Xpeak service that should 
be initialized within the Xpeaker plugin. 

 Adjust Size: This option allows to equalize the width or 
height of several selected fields. 

 Align: This option allows to equalize the horizontal 
coordinates of several selected fields. 
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ECLIPSE PREFERENCES 

The integration of the Plug-In Xpeaker within Eclipse is so complete 
that it turns to its utility Preferences for the maintenance of the 

application variables, adding a new section (Xpeaker) to those 
existing within Eclipse. 

To access, select the menu option Window/Preferences and then from 
within Xpring select the section which is to be consulted or modified.  

 

GENERAL 

Accesses the panel XPreferencesMain and keeps the following 

Xpeaker global values:  

 Xpeaker Path: Indicates the local directory in which the 

Xpeaker files, such as Services Packs, Service Configurations, 

Images, Documents, etc. are located. 

 Last services launched: Maximum number of services kept in 

the historical, the window under the services tree. 
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 Server Ports: Maximum number of TCP/IP ports starting from 

the initial port to be used by the Xpeak servers. 

Answer Ports: Maximum number of TCP/IP ports starting from the 
initial port to be used by the Xpeak servers to transmit the events, 

errors and traces. 

 Max. XML length:  Maximum XML length to be traced. If the XML 

exceeds this length, the trace will be truncated with dots ('…') 

FORMS 

Shows a panel which maintains the variables utilised by the Forms 

Viewer to locate the form archives which will be shown in the tree:  

 

 Forms Path: Indicates the directory in which the forms will be 

searched for.  

 Font Mapping: This table creates a correspondence between the 

font names used by the application in the forms and the font 
names accepted by the Xpeak Services. 
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RESOURCE SAFE 

This panel shows the configuration parameters for the server from 
which the source code of the Xpeak services will be downloaded. 

 

Keeps the following variables: 

 Centre:  

o Host: URL where the update service is located. By default 
this will be 

http://www.cashware.biz/XpeakerResourceSafe/. 

o Time Out: Waiting time for the connection. The default 

value is 10000 milliseconds.  

o User: User name provided for the updates service.  

o Password: Access password which has been provided for 
the updates service.  
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 Proxy: If the network is accessed through a Proxy, the following 

data should be indicated: 

o Type: Type of Proxy, which may be NONE, HTTP or 
SOCKS. 

o Host: Server name. 

o Port: Access port. 

o User: User name within the Proxy. 

o Password: Access password for Proxy. 

SERVERS  

With this option it is possible to edit the configuration of the existing 
Xpeak servers, delete them or create new ones. 
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The process of creating a Xpeak server involves introducing some 

parameters. After pressing the ‘New’ button, this window will show 

up: 

 

There are four types of Xpeak server depending on the location of the 
Xpeak classes: 

- Local Workspace: Classes are taken from the 
corresponding project in the eclipse workspace. The 

project will be named 'XpeakServices-Xpeaker' or 

'XpeakServices-XpeakerPro' depending on the license 

type. 

- Remote Server: Classes are taken form a XpeakServer 
executing in a remote server. 

- Pack: Classes are taken from a jar file. 

- Folder: Classes are taken from an arbitrary directory. 
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If the option ‘Launch Manually’ is not selected, then the Xpeak server 

will launch automatically when opening the Xpeaker view in eclipse. 

 

In the next dialog the type of communication with the Xpeak server 

needs to be specified: 
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XPEAK PACKS GENERATION 

One of the useful functionalities of Xpeaker is the creation of jar files 
containing a set of Xpeak services and a Xpeak server for deployment 

purposes. 

The necessary classes of these services and the server will come 

packed in a JAR file, with the necessary obfuscations. 

The steps to create a Package are the following: 

1. Open the Generate Pack dialog using the Generate Pack option 
in the menu. 

2. Add the Xpeak services necessary for the Project. This can be 
done by double-clicking on the specific service or pressing the 

arrow button. 

 

 Note that it is possible to select the name of the output file in 
 the Name field and also that it is required to select a Xpeak 

 Server of type Pack in the Server field in order to generate the 
 pack. 

 The list of services associated with this pack can be saved by 
 pressing the Save button.  
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3. Finally, the JAR file should be generated which includes the 

classes of the different devices selected, with the relevant 

obfuscations and the public access classes. This can be done by 
pressing the Generate button. 

 Pressing this button will directly access the generation process 
 which shows a dialog box with the added packs, and the 

 incidents and errors which have been produced.  

 


